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TS REPORTSERVER

TS ReportServer takes output from Report-IV on the host and presents it graphically at the
workstation. It is fully integrated with VIP but does not require that the graphical presentation be
installed or enabled, meaning it will also work when running your application in character mode.
You can also use TS ReportServer with Gateway for Windows.

Setup

The Thoroughbred Environment includes the RPSERYV printer table. From the System
Administration menu select Printer Assignment. For more information see the Dictionary-IV
Administrator Guide. Assign any printer device (i.e. RS, LP, P1) to the RPSERYV printer table.
The recommended printer device is RS. You will then need to modify your IPLINPUT file to
include this printer device.

For more information see the Thoroughbred Basic Customization and Tuning Guide.

IPLINPUT for Windows Basic:

DEV RS,4,,,,,,NUL
or
DEV RS,4,,,,,,file-name

Where file-name is the name of any text file defined in your Thoroughbred Basic Environment
for example, basic-install-path\Tbsc\RSText.txt

IPLINPUT for UNIX:

DEV RS,4,,,1,,,/dev/null
For more help on how to use the TS ReportServer
e Select vip-install-path\Ts1\Bin\Rps.hlp, or
e Select Help and then select Help Index from the TS ReportServer menu bar.

For more information see the Thoroughbred Basic Customization and Tuning Guide.

Creating and Sending Report-IV Output to TS ReportServer

TS ReportServer is included as a standard output device in the Dictionary-1V printer selection
prompt:

ISElect Printer |( LF FAL R PF PN ) :IRS I

When TS ReportServer is selected as the output device, the report will automatically be
displayed by the TS ReportServer on the client.
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&f Thoroughbred RPS Server - Samplel.rps = IEllil

File Edit Wiew Options ‘window Help

EEIEEEIET

RETEY
DE-RCUST Sample System - Customer Listing Page: 1
09/20/96 a2:49 AM  —
Cust

Code --- Gontact -—— -—--———- Hame ---——- -———- City -——— St SR -- Sales —-
108188 Tex Rogers Toot-Your-Horn Port Lavaca TX AF 15,827 .88
180161 David Kelly Fix-#-Up Seadrift TA HP 16,253.36
188182 Sue Thompson Computer Inc. Hadison HJ JJd 16,628.04
188183 Robert Brock Today's Company Bridgevater HJ J5 16,951.84
180184 Sarah Smith ACHME Inc. Dayton HJ AF 17,222.36
100185 UWalter Snider Lumber Inc. Big Horn HD HP 17,442 00
188186 Dennis Gohlke 0K Development Port Lavaca Td JJd 17,609.96
188187 John Dworaczyk  HMemory Lanes Victoria T% JsS 18,318.16
222221 TEHWP CU3STA TEMP CUSTH Port Lavaca Td 21 13,75%.88
222222 TEHWP CUST2 TEMP CUST2 Port Lavaca TH 22 13,226.85
222220 TEHWP CUSTA TEMP CUSTA Port Lavaca TH A 15,135.78
222222 Deleted custs Deleted custs 22 -a8

|«

1<| < | Paget |>|>|||

Ready [Page 1 [ 4

TS ReportServer can display multiple reports. Each report is displayed in a window contained by
one common TS ReportServer GUI Server window.

&F Thoroughbred RPS Server - Sampled.rps = IEllil

File Edit Wiew Options ‘window Help

EEIEEEIET

|‘

0E

Lk oE =

I =) DE-RIMUH Sample System - Invoice Header

== B9/20/%6 89:49 AM

18

18 Invoice —————-— Company Hame----—- ——| Date—— -—— Amount--- -- Credits-- --Payments—-

18

18 8066881 Toot-Your-Horn 81/12/96 241,93 .88 .88

28 0800802 Fix-M-Up 81/13/96 L7B.82 .88 .88

20 d0@aa3 Computer Inc. 81/14/96 684.30 .88 -a8

20 aoeaas Today's Company 81/15/96 88477 .aa .aa

28 808885 ACHE Inc. 81/16/96 1871.3¢ .88 ]

38 808886 Lumber Inc. 81/17/96 1244 .19 .88 .88

38 8060887 0K Development 81/18/96 14832 .18 .88 .88

38 800088 HMemory Lanes 81712796 154833 .88 .88

30 a008a¢ TEMP CUSTH a1/28/%6 2208 .45 .88 -8 _|

]3 808818 TEWP CUsST2 81/21/96 2246 47 .88 ]
808811 TEWP CUSTA 81/22/96 2699.1¢ .88 ]
806812 Toot-Your-Horn 81/23/96 2983.13 .88 .88 .
i 5
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Any report displayed by TS ReportServer can be saved locally on the client. By default, the file
is saved in TS ReportServer format (with the .rpt file extension) in vip-install-path\TSI\Reports.
For more information on saving and opening local report files please see "Save a Report" later in
this manual.
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An application performing CONNECT REPORT can control the output device by pre-setting the
printer id. This allows the application to send the report output to the TS ReportServer without
user intervention.

If the TS ReportServer is available, Query-IV sends all terminal output to the TS ReportServer
for processing. Your application can duplicate this process. Query-IV uses the following tests to
determine if the TS ReportServer is available:

Is the default output set to the terminal?
FID(0)

Does the Global variable RPSERYV exist?
CGV ("RPSERV")

Does the Workstation have GUI capabilities?
#IDVIP.GUI-ON="Y"

If these tests determine that the TS ReportServer is available set the output device to the Global
variable RPSERV.

LET REPORTS$ [6] =cgv ("RPSERV")

CONNECT Report "report-name"

3
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TS REPORTSERVER WINDOW

The main TS ReportServer GUI Server window is displayed when TS ReportServer is selected
as the output device on the host or when you select the TS ReportServer icon on the client from
the VIP program group.

& Thoroughbred RPS Server o ] 4]

Fil= Options Help

|| 2| & 2] &l

|<|<| Page 1 | >|>|||
e Poge o
File
Open an rps file

Print Setup to select the printer properties, etc.

Print Setup 21

— Frinter
Mame: Aipple Las Properties... |
Status: Ready
Type: Aipple Lagera/iter | NT w47.0
“Where:  LPT1:
Comment:

— Paper Orientation
Size: ILetter j &+ Portrait
Source; |Automalical|y Select j " Landscape
Metwark. .. | oK I Cancel |

Recent Files to select from the last files opened.

4

Copyright 2007 Thoroughbred Software International, Inc.



Exit TS ReportServer.
Options

Check (display) or uncheck (remove) the Status Bar, Pagebar, and Toolbar from the TS
ReportServer window. See the graphic above to see where these are located.

Check Paged Scroll to scroll the last 100 pages of the report history.

Help
Access TS ReportServer help.

Open a Report

From the TS ReportServer window select the File menu and then select Open.

open 2| x|

Look in: Ilﬂ Fieports j - = E9-
Samplel.rps

Samplez.rps
Sample3.rps
Sample4.rps
Samples.rps

File: name: | Open

Files of type: IThoroughbred Reparts [*rps) j Cancel |
A

Note: TS ReportServer can only open (display) files that have been saved in .rps
format.

The .rps files above are sample reports that are stored in vip-install-path\TSI\Reports. Select
Samplel.rps and the following report appears.

5
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&f Thoroughbred RPS Server - Samplel.rps = IEllil

File Edit Wiew Options ‘window Help

EEIEEEIET

DE-RCUST Sample System - Customer Listing Page: 1
09/20/96 a2:49 AM  —
Cust

Code --- Gontact -—— -—--———- Hame ---——- -———- City -——— St SR -- Sales —-
108188 Tex Rogers Toot-Your-Horn Port Lavaca TX AF 15,827 .88
180161 David Kelly Fix-#-Up Seadrift TA HP 16,253.36
188182 Sue Thompson Computer Inc. Hadison HJ JJd 16,628.04
188183 Robert Brock Today's Company Bridgevater HJ J5 16,951.84
180184 Sarah Smith ACHME Inc. Dayton HJ AF 17,222.36
100185 UWalter Snider Lumber Inc. Big Horn HD HP 17,442 00
188186 Dennis Gohlke 0K Development Port Lavaca Td JJd 17,609.96
188187 John Dworaczyk  HMemory Lanes Victoria T% JsS 18,318.16
222221 TEHWP CU3STA TEMP CUSTH Port Lavaca Td 21 13,75%.88
222222 TEHWP CUST2 TEMP CUST2 Port Lavaca TH 22 13,226.85
222220 TEHWP CUSTA TEMP CUSTA Port Lavaca TH A 15,135.78
222222 Deleted custs Deleted custs 22 -a8

|«

1<| < | Paget |>|>|||

Ready [Page 1 [ 4

Note: The TS ReportServer can handle multiple reports as well as split screen
viewing within a report. See below.

Menus
File
Open an .rps file located in vip-install-path\TSI\Reports.
Close the currently highlighted report.
Save the currently highlighted report.
Save As an .rps or .txt file.
Print the currently highlighted report.
Print Preview of the report before printing.

Print Setup
Displays the dialog box below so you can select the printer, paper size, orientation, etc.

6
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rintsetun x|

— Printer
MNarme: Froperties... |
Status: Ready
Type: Apple Laserwiiter [ MT «+47.0
“Where:  LPTH:
Cormmett:
— Paper Orientation
Sizer I Letter = " Portrait
Source: IAutomaticaIIy Select j (e Landscape
Metwork. .. | oK I Cancel

Recent Files displayed are listed.
Exit TS ReportServer
Edit - Select Copy, Find or Select All
View — Select Zoom In, Zoom Out, or select the Font.

Options — Select to view any or all of the following: Toolbar, Pagebar, Status Bar or Paged
Scroll.

Window — Select to Cascade or Tile the windows. You can also Arrange Icons. This simply
means that when you minimize a report window, an icon for the report displays at the bottom of
the window (see below).

&f Thoroughbred RPS Server - SampleS.rps = IEllil

File Edit Wiew Options ‘window Help

=(E| B S(7| alal

ES'sample L.epsf=] =] [ES| | B

1<| <] Paget |>|>|||

Ready [Page 1 [ 4
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and you move one of the "icons" (see below).

= Thoroughbred RPS Server - SampleS.rps - |D|5|

File Edit View Options ‘Window Help

=(d| B 52| ol

|<|<| Page 1 | >|>|||
Ready |Page 1 I_IWI_ v

Select Windows—> Arrange Icons to place them back at the bottom of the screen (see below).

&f Thoroughbred RPS Server - SampleS.rps = IEllil

File Edit Wiew Options ‘window Help

=(E| B S(7| alal

B sioix
i< <] Pager | >|>|||
Ready [Page 1 [ 4

Help — Select the Help index or find the version number (About).
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Toolbar

The Toolbar can be moved using normal Windows procedures. The following buttons are
available from the Toolbar:

- |
E’l El Open and Save

Open — This button allows you to open an .rps file to edit.

Save — This button allows you to save the file (the first time opened) or to save edits to the
report.

Note: From the File menu you can save the report as *.rps, or *.txt files. From the
Edit menu you can copy the report to the clipboard, make changes to the report
and save, or exit without saving. For more information see Saving a Report.

Copy

Copy — This button allows you to copy the edited file to the clipboard.

%l I:E |Print and About

Print — This button allows you to print the edited file.

About — This button displays the TS ReportServer version.

@% | ront Size and Find

Font Size — This button allows you to zoom in or out in the report.

Find — This button allows you to search the file for characters, numbers or words.
Split Screen Viewing

With TS ReportServer you can split reports both vertically and horizontally. Each pane contains
a set of scroll bars allowing each to be scrolled independently of the other. It supports a total of
four panes: two vertical split panes and two horizontal split panes.

9
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IOl
File Edit View Options ‘Window Help
=\ d| & 57| aln
=101x|
OE-RCUST Sample System - Customer Listing Page: 1
09/20/96 B9:49 AM —
Cust
Code --- Gontact -— -—--———- Hame ---——- -———- City -———— 3t SR -- 5ales —-
188188 Tex Rogers Toot-Your-Horn Port Lavaca TR AF 15,827 .08
180181 David Kelly Fix-H-Up Seadrift T HP 16,253.36
188182 Sue Thompson Computer Inc. Hadison HJ 16,628 .04
188183 Robert Brock Today's Company Bridgeuwater HJ JS  16,951.84
188184 Sarah Smith ACME Inc. Dayton NJ AF 17,222.36
1008105 Walter Snider Lumber Inc. Big Horn HD HP 17,442 .08
180186 Dennis Gohlke 0K Development Port Lavaca T8 JJ 17,6089.96
180187 John Dworaczyk  Hemory Lanes Uictoria TZ JS  18,318.16
222221 TEHWP CUSTA TEMP CUSTH Port Lavaca T 21 13,759.80
2227222 TEMP CUST2 TEMP CUST2 Port Lavaca Td 22 13,226.85
22Z2ZZA TEWP CUSTA TEMP CUSTA Port Lavaca T JJd 15,135.78
222222 Deleted custs Deleted custs 22 -80
178,366.35
-
Kl I H
|<|<| Page 1 | >|>|||
Rlady Page 1 UM v

split screen.

Grab for horizontally

To create two vertical panes

Grab for vertically
split screen.

Grab the little button on top of the vertical scroll bar (see graphic above) and then drag your

mouse down.

= Thoroughbred RPS Server - Samplel.rps

File Edit View Options ‘Window Help

=lol x|

=\ d| & 57| aln

=101

|0 CUST Sample System - Customer Listing Page: 1 =
09/20/96 B9:49 AW

Cust

Code --- Gontact -— -—--———- Hame ---——- -———- City -———— St SR -- Sales —-
188188 Tex Rogers Toot-Your-Horn Port Lavaca TR AF 15,827 .08
180181 David Kelly Fix-H-Up Seadrift T HP 16,253.36
188182 Sue Thompson Computer Inc. Hadison HJ 16,628 .04
188183 Robert Brock Today's Company Bridgeuwater HJ JS  16,951.84
188184 Sarah Smith ACME Inc. Dayton NJ AF 17,222.36
100185 UWalter Snider Lumber Inc. Biq Horn HD HP 17,442 .08 ‘:J
OE-RCUST Sample System - Customer Listing Page: 1 4
82/28/96 A9:49 AM

Cust

Code --- Gontact -—— -—--——- Hame ---—-—- -———- City -——— St SR -- Sales —-
180188 Tex Rogers Toot-Your-Horn Port Lavaca T AF 15,827 .08
188181 David Kelly Fix-#-Up seadrift T& HP 16,253.36
188182 Sue Thompson Computer Inc. Hadison HJ JdJd 16,628.04
188183 Robert Brock Today's Company Bridgevater HJ J3 16,951.04
180184 Sarah Smith ACHME Inc. Dayton HJ AF 17,222.36
180185 Ualter Snider Lumber Inc. Big Horn HD HP 17,442 .08 —
1808186 Dennis Gohlke 0K Development Port Lavaca TH JJ 17,689.96 -
i ot iemmrene 1 anoe e : ;DI
|<|<| Page 1 | >|>|||
Ready Page 1 UM v
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You now have two vertical panes that can be scrolled independently. To create a single pane

reverse the procedure used to create two panes.

To create two horizontal panes

Grab the little button on the left of the horizontal scroll bar (see graphic at the beginning of this

section) and then drag your mouse to the right.

= Thoroughbred RPS Server - Samplel.rps

File Edit View Options ‘Window Help

=lol x|

EEEEREY)

e
|0E*RCUST Sample System |0E*RBUST Sample System - Cus_
09/20/96 09/20/96 —
Cust Cust
Code -—- Contact ——— -—-———-—- Name | Code  -—- Contact -—— -—————-- Name ---
188188 Tex Rogers Toot-Your-Ho (188188 Tex Rogers Toot-Your-Horn
180181 David Kelly Fix-H-Up 160181 David Kelly Fix-H-Up
188182 Sue Thompson Computer Inc (188182 Sue Thompson Computer Inc.
188183 Robert Brock Today's Comp (188183 Robert Brock Today's Company
188184 Sarah Smith ACME Inc. 168184 Sarah Smith ACME Inc.
180185 Walter Snider Lumber Inc. [186185 Walter Snider Lumber Inc.
180186 Dennis Gohlke 0K Developme [188186 Dennis Gohlke 0K Development
188187 John Dworaczyk Hemory Lanes (188187 John Dworaczyk Hemory Lanes
222221 TEHWP CUSTA TEMP CUSTH 222221 TEHWP CUSTA TEMP CUSTAH
2227222 TEMP CUST2 TEMP CUST2 222222 TEMP CUST2 TEMP CUST2
22Z2ZZA TEWP CUSTA TEMP CUSTA 22Z2ZZ2a TEMWP CUSTA TEMP CUSTA
222222 Deleted custs Deleted cust [Z227222 Deleted custs Deleted custs
-
I — 2l H
|<|<| Page 1 | >|>|||
Ready |Page 1 I_IW|_¢

You now have two horizontal panes that can be scrolled independently. To create a single pane

reverse the procedure used to create two panes.

To create four panes

Simply perform the two procedures above and you will have a split screen similar to the one

below.
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& Thoroughbred RPS Server - Samplel.rps = IEllil

File Edit ‘iew ©Options ‘window Help

=(E| B S(7| alal

R
|0E*RCUST Sample SystelUE*RCUST Sample System - Cust «
09/20/96 89/28/96

Cust Cust

Code -—- Contact ——— -—-———-—- Na| Code --- Contact -—- ---——-- Hame ---——-
108188 Tex Rogers Toot-Your- 188188 Tex Rogers Toot-Your-Horn
180181 David Kelly Fix-M-Up [188181 Dawid Kelly Fix-H-Up

188182 Sue Thompson Computer I[|188182 Sue Thompson Computer Inc.

188183 Robert Brock Today's Co 188183 Robert Brock Today's Company s
188184 Sarah Smith ACME Inc. [186184 Sarah Smith ACHE Inc. :J
DE-RCUST sample Syste [JE-RCUST Sample System — Cust a
09/20/96 69/20/96

Cust Cust

Code --- Contact -—— -—--——- Na| Code --- Contact --—- ---——- Hame ----—-
188188 Tex Rogers Toot-Your- [188188 Tex Rogers Toot-Your-Horn
100181 David Kelly Fix-M-Up [188181 David Kelly Fix-H-Up

188182 Sue Thompson Computer I 188182 Sue Thompson Computer Inc.

188183 Robert Brock Today's Co 188183 Robert Brock Today's Company
180184 Sarah Smith ACHE Inc. [188184 Sarah Smith ACHE Inc.

.‘],..,, s P e 'ﬂ e S e -

1<| < | Paget |>|>|||

Ready [Page 1 [ 4

The frame can be resized using normal Windows procedure. Grab any side or corner and enlarge
or decrease the size.

Save a Report
TS ReportServer allows you to save a report in two formats.
Saving as a Thoroughbred Reports file (*.rps)

e From the File menu select Save and the report will be saved to the vip-install-
path\TSI\Reports folder.

e From the File menu select Save As and then you can save the report as a TS ReportServer
file (.rps) in the folder of your choice.

Saving in a different format

From the File menu select Save As and then you can save the report as a text file (txt) in the
folder of your choice.

Note: TS ReportServer can only display reports that are saved in .rps format.
Once a report is saved as a text file, TS ReportServer cannot be used to open it.

Copying to the Clipboard

From the Edit menu select Copy and then you can Paste the report in any DDE compliant
application.

12
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GATEWAY FOR WINDOWS

The host program requires a simple communication. Each page uses a single CALL to the
program RPSCOM.

Terminate each line on the page with:

CRLF (CHR(13)+CHR(10))

Terminate each page with:

FF (CHR(12))
page-of-data" + CHR(12)

Prefix the CRLF at the end of each line with a CHR(11) to indicate a heading line.

CHR(11l) + CRLF

The TS ReportServer displays a dialog status box as each page is received and processed.
Append the following instruction to the final page of the report:

"page-of-data-for-last-page"” + "[.END.]"

The TS ReportServer immediately displays the report. It allows complete user manipulation and
processing of the report, including forward and backward scrolling, printing to a file, and saving
to a file.

Example

The following example illustrates the simplicity of the host programming required to invoke TS
ReportServer.

00010 REM &REM&

00020 BEGIN;

DIM MS$I[5];
!Gateway call string
LINEENDS$=CHR (13) +CHR (10), 1End of
line indicator
HEADLINEENDS$=CHR (11l) +LINEENDS, IEnd of heading
indicator
LASTS$="[.END.]" ILast

page indicator

13
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00100 M$[1]="I4",
M$ [2] ="RPS",

M$ [3]1="SYSTEM",
M$[5]1="[.LOAD.]";

CALL "RPSCOM",MS$ [ALL] ;
IF M$[0]l<>".n"
GOTO 9000
ELSE
M$[1]="P",
M$ [5] =Wk%kn
"UTSAMPLE" +
! (11,40) =Report Description
"Gateway for Windows Test Report
"080"+
width
II060II;
lines/page

CALL "RPSCOM",MS$ [ALL]
00200 REM PAGEl

00210 p$="",

P$=P$+" HEADING LINE 1 "+HEADLINEENDS,
P$=P$+" HEADING LINE 2 "+HEADLINEENDS,
P$=P$+"DETAIL LINE 1 "+LINEENDS,
P$=P$+"DETAIL LINE 2 "+LINEENDS,
P$=P$+"DETAIL LINE N "+LINEENDS,
P$=P$+CHR (12) ;

GOSUB 1000

00220 REM PAGE2 THRU PAGEn

00230 pP$="",

P$=P$+" HEADING LINE 1 "+HEADLINEENDS,
P$=P$+" HEADING LINE 2 "+HEADLINEENDS,
P$=P$+"DETAIL LINE 1 "+LINEENDS,
P$=P$+"DETAIL LINE 2 "+LINEENDS$,
P$=P$+"DETAIL LINE N "+LINEENDS,
P$=P$+CHR (12) ;

GOSUB 1000

00240 REM LAST PAGE

00250 pPg="",

P$=P$+" HEADING LINE 1 "+HEADLINEENDS,
P$=P$+" HEADING LINE 2 "+HEADLINEENDS,
P$=P$+"DETAIL LINE 1 "+LINEENDS,
P$=P$+"DETAIL LINE 2 "+LINEENDS$,
P$=P$+"DETAIL LINE N "+LINEENDS$,
P$=P$+LASTS;

GOSUB 1000;
GOTO 9000
14
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!Define Report Message:

1 (1’2)=II**II
1(3,8)=Report name

! (51,3) =Report

! (54, 3) =Number

of



01000 M$[5]1=P$;
CALL "RPSCOM",M$ [ALL];
RETURN

09000 RUN "*=*n

15
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MULTI-LANGUAGE

For more information about Multi-Language, see the Dialog, Message, and MenuBar Text
Translations section in the Multi-Language for VIP.

16
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